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Compendium Basics Exercise 
This is a short (approx. 30 minute) exercise to help you start using Compendium for Issue 
Mapping; the process of creating IBIS (Issue Based Information Systems) diagrams.  
 
This exercise assumes that  
 

• you have a working knowledge of your operating system (Windows or Mac OS) 
• you have downloaded Compendium1 version 1.5.3 Alpha 5 (free) from the CogNexus 

website 
o PC users: http://www.cognexus.org/Compendium_downloads/compendium-

1.5.3-alpha5.exe  
o Mac users: http://www.cognexus.org/Compendium_downloads/compendium-

1.5.3-alpha5.dmg  
• you have gone through the installation process.  

 
At the end of this exercise you will have created a map that looks like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                
1 NOTE: Some of the screen shots in this tutorial will not match exactly what you will see on your screen due to 
differences in version of the Compendium software. The differences are minor and should not affect the 
functionality you need for this exercise. 
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Part I: Exercise Steps 
 

1. Launch Compendium. 

2. If this is the first time you have started Compendium, you will be asked to create a 
new Project. Name it something like “My Project” and fill in the Author Name field 
with your first name. This information is case sensitive. Check the boxes “Make this 
your default project” and “Make the user below, the default user”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(NOTE: Don’t create more than one Project for now. Inside this Project you will create all the 
Maps you need.2) 

 

If you are then asked to log into your project, go ahead and do that.  

 

                                                
2 Think of a Project as being like your desktop, and a Map as being like a folder on your desktop. 
Don’t create a new Project when all you need is a new Map.  Generally, you won’t need many 
Projects. 

Check these boxes 

Type your name here. 
 

Remember your Login 
Name and Password! 
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When you complete the login, your screen will look something like this:   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Close the Outline View, if it is open. 

4. Change "Icon Set" to "Default_Mini"  

In Windows use: Tools, User Options, Misc tab 
In Mac OS use: Tools, User Preferences, Misc tab 

5. Turn off "Auto Label Searching" (View, Auto Label Searching) 

6. Double click on the ‘Quick Start’ Map icon; it opens to show a window that looks like 
this: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Close the 
Outline View 
(if it is open) 

A Map named 
“Quick Start” 
 

Your InBox (a groupware feature) 
 

A Map to Compendium’s 
Funders and Contributors 
 

The Trash Bin (like 
Windows’ ‘Recycle 
Bin’) 
 

The Quick Start Map opens to 
show you: 

1) another Map (“Welcome…”),  
2) a link to a video, and  
3) two links to websites 
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7. Launch the QuickStart video (local). This is very short video that will give you a quick 

look at what you can do with Compendium. You'll hear Simon Buckingham-Shum 
(who directs the development of Compendium at the Open University in the UK) 
talking about Compendium and walking through the basic operations and terms. 
Make sure your sound is turned up so that you can hear his voice.  

NOTE: The icons used in the video are NOT the same as the icons in the current 
version of Compendium. The basic ideas, though, are the same; so don’t be 
confused or concerned that the icons look different. 

8. When you’re done, close the Quick Start window.  Click on the Window menu item 
and select “Home Window” from the options. 

9. Okay, now we’re going to create a new Map in your Home Window. There are 
several ways to bring icons onto your screen, but we are going to use the simplest 
one for now. 

10. Click on the Map 
icon  in the toolbar 
on the left side of the 
screen and drag it 
onto your screen:  

11. Type the text 
“Budget Exercise” in 
the label area (where 
your cursor is) and 
then Enter or Return. 
This completes 
labeling your new 
Map node and opens its window, which is of course empty.  Notice that you didn’t 
need to click anything to be able to type the label name.   
 
Now you have an empty Map window: 

 
 

THINGS TO REMEMBER: 

1. There is no “Save” command.  
Everything you do is immediately 
saved in the Compendium 
database. 

2. In general you should create a 
new Map for each new topic or 
major issue that you want to 
explore in Compendium.   

3. Another way to create a new Map 
is to position your cursor where 
you want the new Map icon on 
the screen, and type “M” on your 
keyboard… a new Map node 
appears.  Type in a label, press 
Enter or Return, and you’ll be in 
your new, empty map. 



 

 
 
 
© 2010 v1k  page 5 
 

12. Pretend you are in a meeting for a small school district and they have determined 
previously that there is a budget shortfall for the coming year. The people in the 
meeting will be working to come up with some solutions and ideas to address the 
issue. You will be listening for Questions, Ideas (answers), and Pro and Con 
arguments. It’s your job to capture all these elements and create a visual display of 
the meeting’s discussion in Compendium.  For 
this exercise we’ll guide you through the specific 
steps of doing that.  

13. Drag a Question icon  to the screen and label it 
“What should we do about the budget?” 

Note: Always end the label of a Question with a 
question mark. 

14. Suppose three people in the meeting each voice 
an Idea as answer to this Question. Create three 
Idea  nodes and label them as shown below.  
You can create these by dragging the Idea icon to 
the screen or by typing the letter “I” (for Idea) on 
your keyboard, after you have clicked the mouse 
in the window where you want the new node to 
appear. 

Note: Use sentence case (capitalize the first 
word) for all your node labels. 

Link the Ideas to the Question by putting your cursor on an Idea and doing a Right 
Drag3 to create an arrow from the Idea to the Question.  Notice that the link goes 
from right to left – this is very important.   One of the rules of using Compendium for 
IBIS or Issue Mapping is that links go from the right to the left. 

 

 

 

 

 

 

 

 

 

 

 

                                                
3  Windows: With the cursor over an Idea node (so the node has a blue focus box around it), hold 
down the Right mouse button and move the cursor until the Question node is in focus (blue box).  
Now release the mouse button.   
Mac:  Press the Option key and hold it down. With the cursor over an Idea node (so the node has a 
blue focus box around it), hold down the mouse button and move the cursor until the Question node 
is in focus (blue box).  Now release the mouse button and then the Option button. 

Note: if you don’t like 
where a Node is placed 
you can easily move it. 
 
On Windows:  Place your 
cursor over the node, 
hold down the left mouse 
button and move the 
Node to where you want. 
(That’s called a “Left 
Drag”) 
 
On Mac: Place your 
cursor over the node, 
hold down the mouse 
button and move the 
Node to where you want. 
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Your window inside Compendium may need to be enlarged a little bit at this point to 
accommodate the addition of more nodes, so drag the right side of the window over 
several inches (or just maximize it). 

15. “But we just cut costs last year!” someone says.   

So add a Con node  by dragging the Con icon to the screen, or by typing “-“ on 
your keyboard, after clicking where you want the new Con node to appear.  Label it 
“Just went through cost cutting last year”, and Right Drag a link to “Cut costs”.  

(Notice that the arrow is automatically drawn in red to denote that the Con “objects 
to” the Idea to which it is linked.) 

Now your screen should look like this: 

 

 

 

 

 

 

 

 

 

 

 

16. Before we go any further with the meeting, let’s explore how a mistake in node type 
creation can be fixed.  Suppose you “accidentally” create a Con node underneath the 
Con node you just created.  Your window will now look like this: 
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To remove (delete) the extra Idea node you have several options: 

• Option 1: First select it by clicking on it, then click on the Delete icon  in 
the tool bar at the top of the window  

• Option 2: Delete from menu 

o Windows: Right Click on the Idea node.  A menu will appear.  Select 
the Delete function from the menu. 

o Mac: Hold down the Control key and click on the Idea node. A menu 
will appear.  Select the Delete function from the menu. 

• Option 3: First select the Idea node by clicking on it.  Then use the Delete key 
on your keyboard 

Pick one of the options, and delete the node.  (You can recreate the node and try the 
other options, if you want.) 

After deleting the Con node, create it again, so your screen once again looks like it 
did in the picture above.   (We’re going to use that extra Con node in the next step.) 

17. Back at the meeting, someone says “Okay, but how do we cuts costs?”  

That is obviously a Question, but you have a Con node on your screen.  Fortunately 
Compendium allows us to change the type of a node quite easily: 

• Windows: Right Click on the Idea node.  A menu will appear.  Select the 
“Change Type To…” item from the menu.  A second menu will appear.  
Select “Question” from that second menu. 

• Mac: Hold down the Control key and click on the Idea node. A menu will 
appear.  Select the “Change Type To…” item from the menu.  A second 
menu will appear.  Select “Question” from that second menu. 

When you have changed the node type, you should have a Question node ready for 
use.  Label it “How can we cut costs?” and add a link from that node to the “Cut 
costs” Idea node.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
 
 
© 2010 v1k  page 8 
 

18. Back at the budget meeting, there are three ideas raised about how to cut costs, and 
you need to capture all three new Ideas: (1) eliminate special programs, (2) cut staff, 
and (3) renegotiate salaries. 

When you are done, your map should look like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

19. As you are adding the “Eliminate special programs” Idea, someone asks, “Which 
special programs should we eliminate?” Put that Question on the screen too: 
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20. While discussing the ‘Renegotiate salaries” Idea, two objections are raised: (1) it 
takes too long, and (2) it is unlikely to work. Map these as Con arguments: 

 

 

 

 

 

 

 

 

 

 

 

21. Now the conversation at the meeting turns to the ‘increase revenue’ idea. Someone 
says that we could petition the county for a tax increase, or we could charge fees for 
special programs. Create these Idea nodes, and then create a Question, “How to 
increase revenue?” just to the left of them. This Question is a “bridge” from the 
“Increase revenue” Idea to the specific Ideas about increasing taxes and fees for 
special programs.  Link them together as shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  To fit the new nodes in, and still keep everything neat, we needed to move 
the some of the other nodes around.  You do this by selecting the nodes and 
dragging them to their new location.   You can select a group of nodes by 
clicking and then dragging the mouse to create a rectangle:  all of the nodes 
inside the rectangle will be selected when you release the mouse button. 
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22. Alright,” someone offers, “but we could also just accept the deficit. There’s a strong 
economic forecast for next year.”  Map “Strong economic forecast” as a Pro  
argument linked to “Accept the deficit”.  To create the Pro node, either drag the Pro 
icon onto the window or type “+” on the keyboard after clicking where you want the 
new Pro node to appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Let’s say the meeting ended here.   In reality, this conversation might go on much longer 
and would result in a much bigger map, including sub-maps regarding the economic 
forecast and other issues.  

When you are done, practice exporting your map to a JPEG file by doing the following: 

1. Go to the File menu, select Export, 
and choose ‘Jpeg File’ from the next 
menu. 

2. Title the file with your name and 
save it to your desktop (or another 
location that you will easily 
remember). 

This exported file could potentially be sent 
by email to others as an attachment.  Using 
JPEGs to share your maps is a good idea 
only when the map is simple, without sub-
maps.  This is because JPEGs don’t allow 
viewers to click into the contents of your 
sub-maps.  As you receive more instruction, 
we will teach you additional options for 
exporting and sharing maps. 
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While this experience is still fresh you might want to write down any questions, concerns, 
ideas, or other thoughts that came up as you went through this exercise.  (You could even 
do it in Compendium!) 

 

Some conventions and commands 

Please study and use these! 

 You can use keyboard short cuts (hot keys) to create nodes more quickly than by 
dragging them from the menu. To use the keyboard rather than the menu, first click in 
the window where you want the new node to appear and then type the letter or character 
on the keyboard.  To create IBIS nodes use the following: 

Q  Question   +  Pro 

 I  Idea    -  Con 

To see a list of keyboard short cuts 

• Windows: Right Click on empty space in your map. Mouse over “Create 
Node” and a drop down menu will show you the node types and their hot 
keys. 

• Mac: Hold down the Command key and click on an empty space in your map. 
Select “Create Node” from the menu, and a new drop down menu will show 
you the available node types and their keyboard short cuts. 
 

 To move a node:   

a. Windows: Left Drag starting over the node to  new location 

b. Mac: Select node and drag it to new location 
 

 To select a group of nodes: 

a. Windows: Left Drag over the empty space surrounding a group of nodes 

b. Mac: Click in the empty space outside of the group of nodes and drag over 
the area until the rectangle contains the entire group.  Release mouse. 
 

 To move a group of nodes: 

a. Windows: Put the cursor over any one of a group of selected nodes and do a 
Left Drag to the new location 

b. Mac: Put the cursor over any one of a group of selected nodes and drag to 
the new location. 
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 To select a node and all of its subnodes (in-pointing arrows) 

a. Windows: Alt-Left-Click:4 over the node 

b. Mac: Hold down the Option key and click the node 
 

 To create a space above a node or set of nodes: 

a. Windows: Alt-Left-Drag in empty space 

b. Mac: Hold down Option and Command keys, then drag cursor through empty 
space 

Note: there is no corresponding way to create horizontal separation. 
 

 Moving around in maps – without using the scroll bars 

a. Windows: You can use Right Drag; the same gesture is used for linking two 
nodes.  If it starts over empty space it moves your view over the map. 

b. Mac: If your mouse has a scroll ball, that works well.  
 

 Consider your Home Window like a desktop.  It should stay small and neat, containing 
Map nodes only. 
 

 Generally, Maps grow from left to right. 
 

 Avoid using the Print function (in the File menu) ... it doesn't work very well and there are 
other better ways to do this that we will talk about in the Issue Mapping Webinar Series 
(IMWS). 

 

 

                                                
4 While holding down the Alt key, click the Left mouse button. 


